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DARKADAPTED SOFTWARE LICENSE
Before opening DarkAdapted, carefully read the following License Agreement. Opening DarkAdapted indicates your acceptance of the terms and conditions of this Agreement. 
If you do not agree to abide by the terms and conditions of this Agreement, promptly return the product to the place of purchase, and your money will be refunded.

A. License. The software accompanying this License (the “Software”) and the related documentation are licensed to you by Stephen E. Hutson. You own the media on which 
the Software is recorded, if applicable, but Stephen E. Hutson retains title to the Software and all related documentation.

This License allows you to use the Software on a single computer and make up to ten (10) copies of the Software in machine-readable form for backup purposes only. You 
must reproduce on such copy the copyright notice and any other proprietary legends that were on the original copy of the Software. You may transfer all your license rights 
in the Software, the backup copies of the Software, the related documentation and a copy of this License to another party, provided the other party reads and agrees to accept 
the terms and conditions of this License, and provided you destroy all copies of the Software in your possession prior to license transfer.

B. Restrictions. The Software contains copyrighted material, trade secrets, and other proprietary material, and in order to protect them, you may not decompile, reverse engi-
neer, disassemble, or otherwise reduce the Software to a human-perceivable form. You may not modify, network, rent, lease, loan, distribute, or create derivative works based 
upon the Software in whole or in part. You may not electronically transmit the Software from one computer to another over a network.

C. Termination. This License is effective until terminated. You may terminate this License at any time by destroying the Software and related documentation and all copies 
thereof. This License will terminate immediately without notice from Stephen E. Hutson if you fail to comply with any provision of this License. Upon termination, you must 
destroy the Software and related documentation and all copies thereof.

D. Exporting. You agree and certify that the Software, its related documentation, nor any copies thereof will be exported outside of the United States except as authorized and 
as permitted by the laws and regulations of the United States of America.

E. Limited Warranty on Media. Stephen E. Hutson warrants the media on which the Software is recorded, if applicable, to be free from defects in materials and workmanship 
under normal use for a period of ninety (90) days from the date of purchase as evidenced by a copy of the receipt. Stephen E. Hutson’s entire liability and exclusive remedy 
will be the replacement of the media not meeting this limited warranty and which are returned to Stephen E. Hutson with a copy of the receipt. Stephen E. Hutson will have 
no responsibility to replace media damaged by accident, abuse, or misapplication. ANY IMPLIED WARRANTIES ON THE MEDIA, INCLUDING THE IMPLIED WARRAN-
TIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE 
DATE OF DELIVERY. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION.

F. Disclaimer of Warranty of Software. You expressly acknowledge and agree that use of the Software is at your sole risk. THE SOFTWARE AND RELATED DOCUMENTA-
TION ARE PROVIDED “AS IS” AND WITHOUT WARRANTY OF ANY KIND AND STEPHEN E. HUTSON EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR 
PURPOSE. STEPHEN E. HUTSON DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT 
THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, 
STEPHEN E. HUTSON DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION 
IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN ADVICE OR INFORMATION GIVEN BY STEPHEN E. 
HUTSON OR ITS REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLU-
SION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

G. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL STEPHEN E. HUTSON OR ITS DIRECTORS, OFFICERS, EMPLOYEES, OR 
AGENTS, BE LIABLE FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES THAT RESULT FROM THE USE OR INABILITY TO USE THE SOFTWARE 
OR RELATED DOCUMENTATION, EVEN IF IT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW THE LIMI-
TATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU.

In no event shall Stephen E. Hutson’s total liability to you for all damages, losses, and causes of action (whether in contract, tort [including negligence], or otherwise) exceed 
the amount paid by you for the Software.

H. Controlling Law and Severability. This License shall be governed by and construed in accordance with the laws of the United States and the State of Illinois.
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Section 1:  
Introduction

 DarkAdapted can dim your screen to the point that it becomes 
unreadable! If this occurs, the default escape sequence is  SHIFT

CONTROL OPTION / ALT , which will return your screen to full bright-
ness.

1.1 — License Agreement
Before using DarkAdapted, carefully read the enclosed Software License 
Agreement. If you do not agree with any provision of this agreement, do not 
use DarkAdapted, and delete all copies of the program. Using DarkAdapted 
indicates your acceptance of the Software License Agreement.

DarkAdapted is freeware, but remains a copyrighted program. Distribution 
of DarkAdapted must include this User Guide and all other documentation.

1.2 — What is DarkAdapted?
DarkAdapted is a gamma control application program. It modifies your 
screen gamma settings so that you may, for example, preserve your dark 
adaptation while using your computer.

DarkAdapted boasts such features as:

•  Includes the same powerful screen adjustment technology as 
ScopeDriver, a full featured telescope control program.

•  Customizable gamma presets. Use predefined settings, create your 
own, and manipulate your presets with ease.

•  High-resolution sliders allow you to adjust red, green, and blue video 
components individually and in real time.

•  Small screen mode hides advanced controls, minimizing the use of 
valuable screen real estate.

•  Gamma toggle keys offer quick switching between full brightness and 
the most recent gamma setting. Modifier keys are full assignable, and 
are available system-wide.

•  Switching to gamma presets is performed via smooth fades, never 
abrupt shifts in screen color or brightness.

•  Control console “remembers” its position on your screen in both its 
minimized and maximized modes.

•  Saved gamma preset is restored when DarkAdapted is launched, and 
reset when DarkAdapted quits.

•  Useful display features show gamma changes’ effects on selected text, 
as well as text on different backgrounds.

•  Useful numeric and graphical readouts of gamma values.
•  In multiple monitor setups, DarkAdapted controls all displays in 

unison.
•  Automatic and/or manual Internet update checking ensures you have 

the latest version.
•  And many other time savers and productivity enhancers.

Additional features available in DarkAdapted Pro include:

•  Independent control windows for multiple display setups.
•  Scheduled gamma fades by day of week, time, and/or sunrise and 

sunset.
• Scroll wheel support for slider motion and Presets pop-up menu.
• Expanded Applescript support.

1.3 — System Requirements
DarkAdapted requires the following hardware setup:

•   Mac: Intel Macintosh or Power Macintosh.
•  Windows: PC capable of running Windows 95 or later.
•  At least 4 MB available RAM (6 MB recommended).
•  At least 2 MB available hard disk space.
•  Windows: Compatible monitor and video card.
•  Mac: Mac OS X: 10.2 or later.
•  Windows: Windows 95 or later.

1.4 — Special Thanks
Special thanks to my wife, Nancy, who put up with endless DarkAdapted 
demonstrations. :-)

1.5 — Trademark Information
All trademarks referenced herein are property of their respective owners.

1.6 — Guide Layout
 This symbol references features or behavior specific to Macintosh 
computers. Such items are not applicable to IBM-compatible PC’s.
 When you see this symbol, the manual discusses features or behav-
ior specific to IBM-compatible computers. Such items do not apply 
to Macintosh computers.

http://www.adpartnership.net/ScopeDriver/index.html
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 This symbol denotes features relevant only to DarkAdapted Pro, 
which operates only on the Macintosh platform.

Throughout this User Guide, menu selections and menu titles are depicted 
using the following typeface: Menu Title

Keyboard equivalents are shown using the Macintosh command-key symbol, 
along with the modifier key(s). For example, S  means that you hold down 
the  (command) key while typing the letter S . 

 If you are using DarkAdapted for Windows, substitute the CONTROL  
key for the  key.
 If a keyboard equivalent with no menu counterpart doesn’t seem 
to be working, simply add the SHIFT  key to implement the action. 
This is necessary because Windows doesn’t allow window key-
board shortcuts that override menu keyboard shortcuts, even 
when the menu is disabled.

Window names appear in boldface, as in Main Window.

DarkAdapted has been designed with ease of use in mind. Any features of 
the program not covered in this brief guide are, hopefully, self-explanatory. 
Your suggestions for improvement are always welcome!

1.7 — Connecting to Our Web Site
Clicking the web address in the Main Window will launch your browser and 
attempt to connect to the DarkAdapted web site. This will work only if you 
have defined a default browser using your system software. 

Section 2:  
Installation and Setup

2.1 — Installation
To install DarkAdapted and its documentation, you’ll follow the below pro-
cedure. You must have at least 12 megabytes of free hard drive space.

 Locate and mount the Macintosh disk image. The disk image will 
contain a folder which contains the DarkAdapted application pro-
gram, documentation, and extras.
 Locate and decompress the downloaded archive. The expanded 
folder contains the DarkAdapted application program and its 
documentation.

•  Drag the DarkAdapted Folder to the desired location.
•  Open the DarkAdapted folder, then double-click the file entitled “Read 

Me.” Read this document, which may contain late-breaking information 
or special instructions.

•  The next step depends on which operating system you are using:
 Double-click the “DarkAdapted X” icon to open DarkAdapted. If 
you find a file named “DarkAdapted.exe,” you have downloaded 
the version for Windows. If you do not have the correct application 
file for your operating system, check the DarkAdapted web site for 
the correct file.
 If you are using a Windows PC, double-click on the icon entitled 

“DarkAdapted.exe.” If you do not have the correct application file 
for your operating system, check the DarkAdapted web site for the 
correct file.

2.2 — First Run
Double-click on the icon representing the DarkAdapted application. The 
Main Window will then appear, as depicted below:

http://www.adpartnership.net/DarkAdapted/index.html
http://www.adpartnership.net/DarkAdapted/index.html
http://www.adpartnership.net/DarkAdapted/index.html
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Main DarkAdapted Window

Note the text that appears below the Presets: pop-up menu. These are the 
keys that you must hold down to return to full screen brightness, in the 
event that your adjustments result in a monitor that’s too dark to read. Press 
these keys once to return to full brightness, and again to return to the previ-
ous gamma setting.

 The default gamma toggle keys on the Mac platform are 
SHIFT  RETURN  (although they may be changed in the Preferences 

Window). All of these keys must be held down simultaneously.
 The default Windows gamma toggle keys are CONTROL  SHIFT  

RETURN  (changeable via the Preferences Window). All of these 
keys must be held down simultaneously. 

 DarkAdapted Pro can present multiple Main Windows, with each 
window appearing on a different screen. In this mode, the gamma 
toggle keys apply to whichever main window appears in front.

The gamma toggle keys may also be used to toggle between full brightness 
and the most recently selected gamma values. Simply release and again press 
the gamma toggle keys to toggle between the two states.

2.3 — Registering DarkAdapted Pro
 DarkAdapted Pro is only available to users running DarkAdapted 
on a Macintosh; it is not available on Windows, owing to gamma 
control limitations on this platform.

After you have launched DarkAdapted a few times, the Register DarkAdapted 
Pro window appears, as illustrated below:

Register DarkAdapted Pro Window

You may also summon the above window at any time by selecting Register 
DarkAdapted Pro… from the Special menu.

DarkAdapted Pro offers several additional features over the basic program, 
including:

•  The ability to control multiple displays independently, using a separate 
Main Window for each display.

•  Scheduling capabilities, including defining events that change gamma val-
ues on particulars days of the week, at certain times, and/or at sunrise or 
sunset. Scheduled events may control all displays and/or a single display.

•  Scroll wheel support for the Presets pop-up menu and the gamma sliders. 
In the case of the gamma sliders, scroll wheel control moves the sliders in 
unison, and offers the option to either preserve or ignore relative gamma 
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intensities. In contrast, selecting Gang Sliders only offers the option to pre-
serve relative gamma intensities.

•  Enhanced Applescript support to support the additional features of 
DarkAdapted Pro.

To immediately obtain a serial number and begin using DarkAdapted Pro’s 
advanced features, connect to the Internet if necessary, then click the Upgrade 
button. You will be directed to our secure web site, where you may immedi-
ately obtain a serial number.

Copy the serial number from your order confirmation screen, then click the 
Paste button to enter it into the Serial Number: test field. Alternatively, you 
may click to select the Serial Number: text entry field, then type your registra-
tion code.

Once a valid serial number has been entered, the Activate button becomes 
operational, and you may click it to complete the upgrade process. All of 
DarkAdapted Pro’s features will then be enabled.

2.4 — Selecting a Preset
DarkAdapted includes several built-in presets, selectable via the Presets: pop-
up menu, as depicted below.

The Presets Pop-up Menu

When a preset is selected, the screen fades to the selected gamma setting.

 The most recent preset selected may be restored when you next 
launch DarkAdapted, by changing the appropriate setting in the 
Preferences Window.

Any preset in the Presets: pop-up menu may also be selected via the keyboard 
whenever the Main Window is frontmost. In the below illustration, the text 
orange has been typed on the keyboard, and so appears above the Presets: 
pop-up menu:

Miscellaneous Options — Preferences Window

DarkAdapted will then automatically display the first preset in the Presets: 
pop-up menu beginning with the text you type. For example, typing ora 
would select a preset named Orange, if that is the first preset in the menu 
beginning with the three letters ora.

 Typing a single SPACE  character will toggle between Full 
Brightness and the last selected gamma setting.

If no entries in the Presets: pop-up menu begin with the text you typed, noth-
ing is selected from the menu, and the text you typed will clear from the 
display after a one-second delay.

The BACKSPACE  key will delete the last character typed.

 Typed entries normally select a matching preset one second after 
you type the last character. To select the matching preset immedi-
ately, press the RETURN  or ENTER  key after typing the preset’s name.

 DarkAdapted Pro users may position the cursor over the Presets: 
pop-up menu and change the selected preset by using the scroll 
wheel on the mouse.

2.5 — Showing Additional Detail
When first launched, DarkAdapted displays its Main Window with all of its 
controls and explanatory text. To display the full (maximized) Main Window 
at any time, click to select the checkbox control entitled Show Details to reveal 
additional controls and displays, as shown below.
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Expanded Main Window

The three slider controls control the primary colors red, green, and blue 
— and they are labeled with the first letter of each color’s name. To the right of 
each control is displayed the actual gamma value of the corresponding color, 
which by default show the current gamma percentage for each primary color. 
You may change the readouts to instead display the actual gamma value 
(between 0 and 255) in the Preferences Window.

Click and drag any slider to change its gamma value.

The four regions near the bottom of this window reveal the results of your 
gamma adjustments. The text field at lower left displays both selected and 
normal text; the remaining displays show both black text and white text on 
backgrounds that correspond to the three primary colors. 

 These display regions are useful in determining whether your changes 
may render text or graphics unreadable under certain circumstances.

2.6 — Showing Less Detail
Click to deselect the Main Window’s Show Details control to minimize the 
Main Window, as depicted below:

Minimized Main Window

When minimized, the Main Window occupies much less screen area, hiding 
the text displays, the gamma sliders, and the text which reminds you which 
gamma toggle keys will restore the screen to full brightness.

 DarkAdapted “remembers” the Main Window’s position inde-
pendently for both its expanded and minimized states. This allows 
you to preserve one desired screen position for the expanded Main 
Window, and a different screen position for when the window is 
minimized.

2.7 — Ganged Sliders
By default, DarkAdapted allows independent control of each gamma channel 
(red, green, and blue). To instead move the sliders in unison, click to select the 
Gang Sliders control in the Main Window, as depicted below:

Ganged Sliders Mode

Note that the width of each slider may be reduced in this mode. This is 
because ganged slider mode preserves the relative red, green, and blue 
values, and DarkAdapted does not allow a value below 0% or greater than 
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100%. The width of the sliders represents the maximum allowable width that 
ensures that no slider can be set to a value that is out-of-range.

 The Gang Sliders control is disabled when at least one slider is at 
100% and at least one slider is at 0%, since no slider can be adjusted 
below 0% or above 100%. 

 If you instead wish to move the sliders in unison without preserving 
relative gamma values, position the mouse over the slider region and 
adjust the scroll wheel on your mouse. Note than scroll wheel support 
is a DarkAdapted Pro feature which requires registration.

The Gang Sliders setting is preserved when you quit and re-open 
DarkAdapted.

2.8 — Saving a Preset
Once you have defined a useful screen gamma value, you will probably want 
to use it again. DarkAdapted provides a simple method by which you may 
add as many presets as you desire. 

Add a preset by selecting Save Current Setting from the Presets: pop-up menu 
(or by selecting Save Current Screen as Preset from the File menu, or by 
typing S ). A window will then appear, where you may enter a descriptive 
name for your preset, as shown below.

Creating a Preset

Enter the desired name for the preset, then click OK to add the preset to the 
top region of the Presets: pop-up menu. If you wish to continue without add-
ing the new preset, simply click Cancel to return to the Main Window.

2.9 — Managing Presets
DarkAdapted gives you control over how your presets appear in the pop-up 
menu, and the program lets you delete, duplicate, and rename presets that 
you have added to the program.

Presets may also be stored in disk files. If you have downloaded a presets file 
— or wish to load one of the sample files included with DarkAdapted — you 

may double-click the presets file or drag it over the DarkAdapted application 
icon to load its contents. You may also load a presets file from the Edit Presets 
Window, as described below.

 Since DarkAdapted does not attempt to modify your Windows 
registry, double-clicking a presets file may not load the file.

You may edit your presets by selecting Edit Presets... from the Presets: pop-up 
menu, by selecting Edit Presets... from the Edit menu, or by typing E . The 
Edit Presets Window appears, as shown below:

Edit Presets Window

Every preset that you have defined or imported from a file will appear in the 
scrolling list. Select all presets by choosing Select All from the Edit menu, or 
by typing A .

To change the name of any preset, double-click a preset (or select it and click 
Rename) to bring up a dialog where you may change the preset’s name.

Duplicate an entry by selecting it and clicking Duplicate to save a copy of a 
preset under a different name.

Delete any number of presets by selecting one or more list entries, then 
click the Delete button (or press the DELETE  or BACKSPACE  key). The selected 
preset(s) will be deleted after a confirming dialog.

 You may skip the confirm deletion dialog by holding down the  
OPTION / ALT  key while deleting the entry as described above.

You may also change the order by which your presets appear in the Main 
Window’s Presets: pop-up menu. Simply click and hold on an entry, then drag 
it to the desired location in the listing.
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You may also organize your presets by adding separators to your listing. 
Clicking the Separator button inserts a separator after the currently selected 
preset. If no preset is selected, a separator is added to the end of the listing. 

DarkAdapted does not allow the following actions: adding a separator when 
another separator is selected, exporting only separators to a file, renaming a 
separator, or duplicating a separator.

The pop-up menu labeled Actions… offers additional options when you click 
on it and hold down the mouse button, as depicted below:

The Actions Pop-up Menu

Select one of the options from this pop-up menu, as described below:

•  When at least one preset is selected, you may choose Save Selected Presets to 
File… to summon a save dialog, where you may specify a name and disk 
location for the presets file. Only the selected preset(s) (and separators, if 
any) will be saved to the disk file.

•  When one or more presets have been defined, you may choose Save All 
Presets to File… to summon a save dialog, where you may specify a name 
and disk location for the presets file. All presets and separators in the scroll-
ing list will be saved to the disk file.

•  When no presets have been defined, you may select Load Presets from File… 
to summon an open dialog, where you may select a presets file from any 
available disk. Any presets and separators in the disk file will populate the 
scrolling presets listing.

•  When one or more presets have been defined, you may choose Load Presets 
from File (append to list)… to summon an open dialog, where you may select 
a presets file from any available disk. Any presets and separators in the disk 
file will be added to the end of the scrolling presets listing, and will become 
selected.

•  When one or more presets have been defined, you may choose Load Presets 
from File (replace list)… to summon a file selection dialog, where you may 
select a presets file from any available disk. Any existing presets will be 
removed from the scrolling listing, and all presets and separators in the disk 
file will populate the scrolling presets listing, and will become selected. You 
may suppress the warning dialog by holding down the OPTION / ALT  key.

•  When at least one preset is selected, you may choose Delete Selection… to 
remove the selected presets and/or separators from the listing. A confirming 
dialog will appear, but you may suppress it by holding down the OPTION / ALT  
key.

•  When at least one preset has been defined, you may choose Delete All… to 
remove all presets and/or separators from the listing. A confirming dialog 
will appear, but it may be avoided by holding down the OPTION / ALT  key.

 When loading or saving presets files, the file selection dialog opens 
at the default presets file directory (folder). This folder is defined 
as being located in the same directory as DarkAdapted, containing 

“Presets” in the folder’s name. If no folder meets this requirement, 
DarkAdapted selects the first folder it may find containing presets 
files. You may override this behavior by holding down the SHIFT  
key while opening or saving presets files.

When you are satisfied with the changes you have made in the Edit Presets 
Window, click the OK button to implement your changes, or click Cancel to 
discard all changes you made since the window opened.

2.10 — Editing Preferences
To summon the Preferences Window, select the Preferences... menu item as 
described below, or type ,  (comma).

 Select Preferences... from the DarkAdapted X menu.
 Select Preferences... from the Edit menu.

The Preferences Window will then appear, as depicted below:
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DarkAdapted Preferences Window

The Preferences Window is where you can customize DarkAdapted to suit 
your tastes and requirements. There are several groups of controls in this 
window, and each group is pictured and described below.

Gamma Toggle Keys — Preferences Window

The Gamma Toggle Keys: section, depicted above, allows you to select which  
keys — when held down simultaneously — will return your monitor to full 
brightness. Pressing the keys again will restore the previous gamma setting. 
Click the Define Keys… button to change the gamma toggle keys, and the fol-
lowing window appears:

Assign Gamma Toggle Keys Window

Select any modifier key(s) by clicking to select the corresponding checkbox 
control, and type a non-modifier key to change the displayed key name. 

 Modifier keys are , SHIFT  , OPTION   and CONTROL  . Non-modifier 
keys are most other keys on your keyboard.
 Modifier keys are CONTROL  , SHIFT  , ALT   and WINDOWS  . Non-modi-
fier keys are most other keys on your keyboard.

 At least one modifier key must be selected. The selected non-modifier 
key appears highlighted to the right of the modifier key controls.

Click OK to save the changes you made to the gamma toggle keys, or click 
Cancel to close the window without changing the key combination.

Gamma Fades — Preferences Window

The section entitled Gamma Fades: contains three controls:

•  The Steps pop-up menu lets you control the speed of gamma transi-
tions. Selecting “1” will result in a nearly instantaneous gamma tran-
sition. The default value of “60” results in a gamma fade which lasts 
approximately one second.

•  Selecting the control labeled Sliders track gamma values during gamma 
fades causes the slider controls in the Main Window to move as their 
corresponding gamma values change.

•  Report gamma values as percentages controls how the current gamma 
values are displayed to the right of the Main Window’s gamma control 
sliders. When selected, the readouts are populated with percentage 
values between zero and 100%. When this control is deselected, the 
slider readouts report the gamma value as integers between zero and 
255. This controls display format only; functionality is not affected by 
this control’s setting.
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Internet Update Checking — Preferences Window

The Internet Update Checking: section controls DarkAdapted’s version check-
ing functionality, as described below:

•  The Check for updates: pop-up menu controls whether DarkAdapted 
checks for updates manually, or automatically at a selectable inter-
val. Select Via “Special” Menu Only to check for newer versions of 
DarkAdapted only when you select Check for Program Updates… 
from the Special menu. If you select Every Week, DarkAdapted will 
check for a newer version every seven days. Selecting Every Month 
causes DarkAdapted to check for updates every thirty days.

•  To also check for newer alpha or beta versions of DarkAdapted, click 
to select Check for pre-release versions if available. Pre-release versions 
of DarkAdapted always check for such releases, regardless of this 
control’s setting.

 An Internet connection must be established in order for update 
checking to occur. If you use a dialup or other Internet connection 
that is not always available, we recommend selecting Via “Special” 
Menu Only from the Check for updates: pop-up menu.

Miscellaneous Options — Preferences Window

The Miscellaneous Options: controls are described below:

•  When the control labeled Restore previous gamma values on program 
launch appears with a checkmark, then DarkAdapted will store the 
state of all gamma sliders (and the Presets popup menu, if applicable) 
when you quit DarkAdapted. The next time you launch DarkAdapted, 
the screen gamma will be returned to the saved values.

 When you reopen DarkAdapted — and its previous state was set 
to control displays independently, all displays will be returned to 

their previous gamma values when Restore previous gamma values 
on program launch is selected.

•  The Refresh gamma values every N seconds checkbox, when selected, 
causes DarkAdapted to re-implement your screen’s gamma settings 
periodically. This may be used, for example, to retain your preferred 
gamma setting when entering and/or exiting a screen saver, which will 
usually interfere with DarkAdapted’s settings. Use the small arrows to 
select a refresh frequency between 1 and 60 seconds.  

•  Click to select Closing Main Window quits DarkAdapted if you want 
DarkAdapted to quit whenever any Main Window is closed (the 
default behavior). De-select this control to simply hide the Main 
Window using its close control. If you hide the window in this man-
ner, you may again show it by selecting Show Main Window from the 
Special menu.

 Because closing the Main Window will leave you with no menubar 
on the Windows platform, Closing Main Window quits DarkAdapted 
is disabled on Windows.

To implement any changes made in the Preferences Window, click the OK 
button, or click Cancel to discard any changes made in this window. 

2.11 — Independent Display Control (Pro Only)
 Independent display control is only available if you have upgrad-
ed to DarkAdapted Pro. To upgrade, select Register DarkAdapted 
Pro… from the Special menu.

By default, DarkAdapted controls all monitors using a single Main Window. 
To instead use separate Main Windows to control multiple monitors, select 
Control Displays Independently from the Edit menu (or type D ). This will 
open multiple windows, one for each connected display.

When in independent display mode, the Control Displays Independently 
menu item appears with a check mark next to it.

 If DarkAdapted Pro is set to not control displays independently, 
and a scheduled event specifies that a gamma fade should apply 
to a specific display, DarkAdapted Pro will automatically enable 
independent display control before executing the event.

DarkAdapted Pro saves the state of independent display control across 
launches.
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2.12 — Scheduled Event Execution (Pro Only)
 Scheduled event execution is only available if you have upgraded 
to DarkAdapted Pro. To upgrade, select Register DarkAdapted 
Pro… from the Special menu.

Many users desire gamma fading that operates on a schedule. For example, 
a planetarium operator may desire that DarkAdapted Pro dim the screen at 
the beginning of a show, or an air traffic controller may wish to brighten the 
screen at sunrise.

DarkAdapted Pro provides a flexible event scheduling mechanism, which 
is accessed via the Scheduling Window. The window may be activated by 
selecting Scheduling… from the Edit menu, or by typing G , in which case 
the Scheduling Window appears, as illustrated below:

Scheduling Window

The control labeled Enable Scheduled Events specifies whether DarkAdapted 
Pro should execute any events you have defined. When the control appears 
with a check mark, DarkAdapted Pro adjusts gammas according to your 
predefined schedule. To prevent scheduled events from executing, click to 
remove the check mark from Enable Scheduled Events.

All events you have defined will appear in this window’s scrolling display. 
You may select an event by clicking on the entry, or select multiple events by 
clicking while holding down your system’s multiple-selection modifier key. 

When one or more events are selected you may delete the selected event(s) 
by clicking the Delete… button. The events will be deleted after you confirm 
your decision in a dialog box, although you may skip the warning by holding 
down the OPTION  key while clicking Delete… .

To make a copy of the selected event, click the Duplicate button. The copy 
appears with a period and a number at the end, and is selected in the sorted 
list. You may then edit the copy as necessary.

You may edit an event by selecting a single event, then clicking the Edit… 
button. You may also edit an event by double-clicking on the event in the 
scrolling listing.

You may create a new event at any time by clicking the New Event… button, 
in which case the Edit Event Window appears, as illustrated below. The Edit 
Event Window also appears when you edit an existing event.

Edit Event Window

Type a descriptive name for the event in the Event Name: text entry field. 
DarkAdapted Pro will warn you if you attempt to add an event with the 
same name as an existing event.
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If you wish for your event to control all monitors in unison, select All Displays 
from the Displays/Monitors: pop-up menu. To instead control only a single 
monitor, select the display number from the pop-up menu.

The Execute on Days controls allow you to specify the days of the week that 
your event should execute. DarkAdapted Pro requires that you select at least 
one day of the week in order to save the event.

Click the On control to select all days of the week; click the Off control to dese-
lect all days. Drag either control over one or more days of the week to apply 
the desired action to every day of week control that you drag over.

 Dragging the On or Off control to the desired day(s) of the week 
eliminates repetitive mouse-clicking, which is especially useful if 
you are defining several events. For example, to select only the 
weekend days (Sunday and Saturday), click On to select all of the 
days (if necessary), then drag the Off control across the weekdays 
to turn them off.

The Event Time: region is where you specify the time of day that the event 
should execute. From the pop-up menu, you may select Time of Day, Sunrise, 
or Sunset.

•  When Time of Day is selected, a control appears wherein you may adjust the 
hour, minute, second, and am/pm state of the event. When you click on the 
hours, minutes, or seconds region of the control, it begins flashing. When 
a value is flashing, you may use the arrow controls to adjust it upward or 
downward. Click the am/pm region to alternate between am (morning) or pm 
(afternoon) times. The flashing ceases after five seconds, or when you click 
another region in the control.

•  When you select wither Sunrise or Sunset, two controls appear. One is 
labeled Offset, and specifies how many minutes before or after sunrise/sun-
set the event should occur. You may adjust the Offset up or down by means 
of the arrow controls. So, for example, to define an event that will execute 
30 minutes before sunset, select Sunset from the pop-up menu, then click the 

“down” arrow control until the Offset reads “–30” minutes. The Offset may be 
adjusted in one-minute increments, with a minimum of –60 and maximum 
of 60 minutes. The Location control is explained below.

When you define an event as occurring based on sunrise or sunset time, 
DarkAdapted Pro requires your location on Earth in order to provide accu-
rate times. If you have never specified your location, the Location Window 
appears the first time you select Sunrise or Sunset from the pop-up menu. 
Thereafter, you may click the Location… button to change your location. The 
Location Window is depicted below:

Location Window

Your longitude and latitude may be obtained from an atlas. Longitude is 
expressed in degrees and minutes; select West from the pop-up menu if your 
location is west of the Greenwich meridian (longitude increases as you move 
westward), or select East if your location is east of Greenwich (longitude 
increases as you move eastward).

Latitude is also expressed in degrees and minutes. Select North from the pop-
up menu if your location is north of the equator; otherwise, select South.

GMT Offset is the number of hours that your time zone differs from Greenwich 
Mean Time. This value will change throughout the year if you observe day-
light saving time. In most cases, it is best to select Obtain from Computer. You 
may also click to deselect Obtain from Computer and choose your offset manu-
ally from the pop-up menu.
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Click OK to save your changes, or Cancel to discard them. If no valid location 
is specified, the Event Time pop-up menu in the Edit Event Window changes 
back to Time of Day. Closing the Location Window returns you to the Edit 
Event Window.

The Edit Event Window’s Screen Gamma region is where you specify the 
gamma color that will be applied to the desired screen(s) when the event 
executes. You may select an existing preset via the Presets: pop-up menu, or 
define custom red, green, and blue values.

Clicking Select by Name forces DarkAdapted Pro to select the gamma color by 
its Preset name. This can be useful if you plan on replacing a preset (in the 
Edit Presets Window) with one with an identical name, but different color 
values. This saves the effort of redefining your events with different colors.

In most cases, however, it is best to leave Select by Name unchecked.

 If you delete a preset that is used by one or more scheduled events, 
DarkAdapted Pro will still be able to set the screen gamma to the 
deleted preset’s former values, unless you check the Select by Name 
option. This is why it’s best to leave Select by Name unchecked.

To save the changes you made in the Edit Event Window, click the OK button, 
and the window closes. To close the window without saving changes, click 
Cancel.

Scheduling Window

The various columns in the Scheduling Window include Name, which is 
simply the name you specified for the scheduled event in the Edit Event 
Window.

The Days column provides a visual representation of the days of the week 
on which the event will execute. Each entry in this column consists of seven 
characters, one for each day of the week, starting with Sunday and ending 
with Saturday. 

If a scheduled event will execute on a particular day of the week, the first let-
ter of the day’s name appears; otherwise, a hyphen (“–”) appears. So, an entry 
in the Days column of “S------” denotes an event that occurs on Sunday 
only; the entry “SMTWTFS” indicates that an event occurs every day; and an 
entry reading “---W-F-” denotes an event that occurs only on Wednesdays 
and Fridays.

The Time column will display either the event’s time of day, or that the event 
occurs at sunrise or sunset. If an event specifies sunrise or sunset, the offset 
(if any) in minutes appears here also.

The column titled Preset denotes the gamma preset applied to the event, if 
any. If the gamma value was specified manually in the Edit Event Window, 
the text “(none)” appears instead.

Color indicates the color that will be applied to the screen(s) when the event 
executes. If the Edit Event Window is used to specify Select by Name, as 
described above, the text “(select by name)” appears here, and DarkAdapted 
Pro will select the preset by its name when the event executes.

The Displays column indicates which display(s) will be affected by the sched-
uled event when it executes.

To save changes to the listed events, click the OK button, which also closes 
the Scheduling Window. Clicking Cancel closes the window, discarding any 
changes made since the Scheduling Window last opened, including any 
changes made in the Edit Event Window.

2.13 — Internet Update Checking
DarkAdapted is able to check for newer versions, provided you have an 
active Internet connection.

 Many error messages are the result of an inactive Internet connec-
tion. Make sure you are connected to the Internet before attempt-
ing to use DarkAdapted’s Internet update checking.

To check for newer program versions, select Check for Program Updates… 
from the File menu.
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If no update is required — DarkAdapted will present a dialog confirming 
that you are already up-to-date. If DarkAdapted determines that a newer 
version is available, the Update Window opens, as depicted below:

Update Window

Near the top of this window are listed the Version and Build Number for the 
currently-running copy of DarkAdapted (“Your Version:”) and for the Newer 
Version: available via the Internet.

The scrolling list may contain the latest changes in the new version, special 
instructions, program news, etc. The Copy command in the Edit menu may 
be used to transfer this text to another program.

Click the Download Newer Version button (at the bottom-right corner of the 
Update Window) to begin the download. A standard dialog will appear, 
where you may select the download destination and optionally change the 
download’s name.

Once the download begins, the two buttons Go to Downloads Page and 
Download Newer Version will disappear, replaced by a download progress dis-
play which reports the download’s status both numerically and graphically.

During a download, the Cancel button serves to terminate the download and 
close the window, after a warning dialog. When no download is in progress, 
clicking Cancel simply closes the Update Window. 

Click the Go to Downloads Page button to open your default web browser and 
display DarkAdapted’s downloads page.

When you click the Download Newer Version button, the version of DarkAdapted 
that matches your platform (Mac OS X or Windows) is automatically selected 
for download. To instead download DarkAdapted for a different comput-
ing platform, right click (Mac: control-click) in a blank area of the Update 
Window to summon the window’s contextual menu, as shown below: 

Update Window’s Contextual Menu

Select the desired version from the menu, then download the file to the 
desired location.

After successfully downloading an update, DarkAdapted instructs you to 
quit the program, expand the archive, and launch the new version to com-
plete the update process.

 You may force the Update Window to show — even if a newer ver-
sion is not available — by holding down the OPTION / ALT  key while 
you select Check for Program Updates… from the File menu. In 
such cases, some of the text in the Update Window will change, 
and the Download Newer Version button’s name will change to 
reflect the update server’s version.
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Section 3:  
AppleScript Guide

3.1 — Introduction
 This section applies only to users running DarkAdapted for 
Mac OS X or Mac OS Classic. If you are using DarkAdapted for 
Windows, you may skip this section.

DarkAdapted contains extensive AppleScript support, allowing you to con-
trol almost every program feature and setting. This enables automated con-
trol of DarkAdapted from other programs or simple AppleScripts.

Additionally, you may obtain information concerning the current screen 
gamma, and store/retrieve preference settings.

A sample AppleScript is included with the standard DarkAdapted down-
load.

3.2 — Command Reference
The following tables summarize DarkAdapted’s AppleScript support. In the 
examples, the “¬“ character indicates that the script’s line wraps to the fol-
lowing line; do not include the “¬“ character in your script.

Command: activate

Syntax: activate

Function: Launches DarkAdapted if it is not already running, and brings the 
Main Window to the front of the window layering order.

Example: tell application "DarkAdapted"
 activate
end tell

Command: quit

Syntax: quit

Function: Quits DarkAdapted if it is running.

Example: tell application "DarkAdapted"
 quit
end tell

Command: savePreferences

Function: Saves all of DarkAdapted’s preference values, and the current 
gamma preset(s) or color values, for possible restoration with the 
restorePreferences command.

Example: tell application "DarkAdapted"
 savePreferences
end tell

Command: restorePreferences

Syntax: restorePreferences [parameter]

Parameters: with restoringGamma or without restoringGamma

Function: If  savePreferences has previously been called, all of 
DarkAdapted’s preference values are restored to their saved values. 
Use with restoringGamma to also restore the saved gamma 
setting(s) (or the saved preset(s), if selected).

Notes: restorePreferences has no effect if savePreferences has 
not previously been called. 

If you specify with restoringGamma, the most recently stored 
gamma setting or preset is restored. If the gamma has never been 
stored, it remains unchanged. 

Examples: tell application "DarkAdapted"
 restorePreferences with restoringGamma
 restorePreferences without restoringGamma
end tell



Page 18 — DarkAdapted User Guide

Command: independentDisplayControl (DarkAdapted Pro only)

Syntax: independentDisplayControl [parameter]

Parameters: true or false 

Function: Specifies whether DarkAdapted Pro should control all displays in 
unison, or each display independently. Specify true  to control 
displays independently, with a separate Main Window for each 
display, or false to control all displays in unison, controlled by a 
single Main Window. 

DarkAdapted Standard simply ignores this command; it only works with 
DarkAdapted Pro.

Examples: tell application "DarkAdapted"
 independentDisplayControl true
 independentDisplayControl false
end tell

Command: selectDisplay (DarkAdapted Pro only)

Syntax: selectDisplay [parameter]

Parameters: An integer corresponding to one of your connected displays. 
Specify 0 for the main display,  1 for the second display, and so 
on.

Returns: boolean

Function: Set the desired display to control via subsequent AppleScript com-
mands, entering Independent Display Mode if necessary. If you 
specify a nonexistent display, the closest valid display is selected.

Setting the display to 1 or higher enables Independent Display 
Mode, if necessary.

This function returns false if a nonexistent display is specified, in 
which case DarkAdapted selects the closest valid display. Otherwise 
this function returns true.  

DarkAdapted Standard simply ignores this command; it only works with 
DarkAdapted Pro.

Examples: tell application "DarkAdapted"
 if not selectDisplay 0 then beep
end tell

Command: getGamma

Syntax: getGamma [parameter]

Parameters: with percentages or without percentages 

Returns: string

Function: Retrieves the current gamma settings in a comma-delimited string. 

If  with percentages is passed, the values are returned as per-
centage values, including tenths of a percent. 

If  without percentages is passed, values are returned in the 
range 0-255. 

The returned values represent the gamma’s red, green, and blue 
components, respectively.

Examples: tell application "DarkAdapted"
 if not setGamma preset "Full Brightness"¬
  then return -- sets the gamma to 100%
 display dialog getGamma with percentages¬
  -- displays "100.0,100.0,100.0"
 display dialog getGamma without percentages¬
  -- displays "255,255,255"
end tell
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Command: setGamma

Syntax: setGamma value [parameter]
or
setGamma preset [parameter]  

Parameters: If using setGamma value [parameter], the parameter must be 
passed as a comma-delimited string of the three integers which rep-
resent the desired gamma’s red, green, and blue components, respec-
tively. Each component value must be in the range zero to 255, with 
255 representing full brightness.

If using setGamma preset [parameter], the parameter 
must be passed as a valid preset name (as it appears in the Main 
Window’s Presets: pop-up menu).

Returns: boolean

Function: Implements a gamma fade. Returns true if an allowable value or 
recognized preset is received, or false if an illegal value or unrec-
ognized preset name is passed.

Notes: DarkAdapted will not allow the gamma value to be set to “0,0,0” — 
because a scripting error could also result in three zero-values being 
passed. To turn the screen off, use, for example, “0,0,1”

Examples: tell application "DarkAdapted"
 if not (setGamma value "255,255,255") then¬
  beep -- full brightness
 if not (setGamma preset "Full Green") then¬
  beep
end tell

Command: displayMainWindow

Syntax: displayMainWindow [parameter]

Parameters: with detailsShowing or without detailsShowing

Function: Use with detailsShowing to display the Main Window at full 
size, or use without detailsShowing to minimize the window.

Examples: tell application "DarkAdapted"
 displayMainWindow with detailsShowing
 displayMainWindow without detailsShowing
end tell

Command: gangSliders

Syntax: gangSliders [parameter]

Parameters: true or false

Function: Specifies whether or not the gamma control sliders move in unison 
when adjusting one slider. Specify true to gang the gamma con-
trol sliders for the selected display(s), or false to set the sliders to 
independent control.

Examples: tell application "DarkAdapted"
 gangSliders true
 gangSliders false
end tell

Command: restoreGammaOnLaunch

Syntax: restoreGammaOnLaunch [parameter]

Parameters: true or false

Function: Specifies whether or not DarkAdapted should restore previous 
gamma settings when it is launched. Specify true to restore previ-
ous settings at launch, or false to start up at full brightness.

Examples: tell application "DarkAdapted"
 restoreGammaOnLaunch true
 restoreGammaOnLaunch false
end tell

Command: fadeSteps

Syntax: fadeSteps [parameter]

Parameters: 1, 15, 30, 60, 90, or 120

Returns: boolean

Function: Specifies the number of steps in gamma fades. Returns true if an 
allowable value is received, or false if an illegal value is passed.

Example: tell application "DarkAdapted"
 if not (fadeSteps 15) then beep
end tell
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Command: toggleKeys

Syntax: toggleKeys [parameter]

Parameters: Any combination of two or more of the following: shift, 
control, option, alt, command, separated by commas.

Optionally, you may also pass keycode='X' and keytext='@Y' 
where X references the Macintosh hardware keycode (in decimal) 
for the desired key, and Y references either the character printed on 
the key or its ASCII value. 

If passing the ASCII value, precede the value by the @ character. 
You must pass both keycode and keytext , or neither.

Returns: boolean

Function: Specifies the modifier keys, and optionally changes the non-modifier 
key, that must be held down in order to toggle the gamma setting 
between full brightness and its last non-full value. Returns true if 
a successful command is received, or false if an illegal value is 
passed.

Example: tell application "DarkAdapted"
 if not (toggleKeys "shift, control, option")¬
  then beep -- just changes modifiers, not key
 if not (toggleKeys "shift,keycode='36',¬
  keytext='@13'then beep -- changes gamma ¬ 
  toggle keys to Shift + Return
 if not (toggleKeys "control,keycode='3',¬
  keytext='F'then beep -- changes gamma ¬ 
  toggle keys to Control + F
end tell

Command: gammaRefreshPeriod

Syntax: gammaRefreshPeriod [parameter]

Parameters: Integer in the range zero to 60.

Function: Specifies how often the screen gamma will be manually re-applied. 
Enter 0 (zero) to turn off gamma refreshing, or specify a period in 
seconds between 1 and 60.

Example: tell application "DarkAdapted"
 gammaRefreshPeriod 30
end tell

Command: doSliderUpdating

Syntax: doSliderUpdating [parameter]

Parameters: with trackingfades or without trackingfades 

Function: Controls whether sliders track gamma fades.

Examples: tell application "DarkAdapted"
 doSliderUpdating with trackingfades 
 doSliderUpdating without trackingfades 
end tell

Command: reportGammaValues

Syntax: reportGammaValues [parameter]

Parameters: with percentages or without percentages 

Function: Controls whether the text readouts (to the right of the gamma slid-
ers) report gamma values as percentages or as raw values.

Examples: tell application "DarkAdapted"
 reportGammaValues with percentages 
 reportGammaValues without percentages 
end tell

Command: updateChecking

Syntax: updateChecking [parameter]

Parameters: with prereleases or without prereleases 

Function: Specifies whether DarkAdapted checks for alpha or beta (“pre-
release”) versions when performing an Internet update check.

Examples: tell application "DarkAdapted"
 updateChecking with prereleases 
 updateChecking without prereleases 
end tell
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Command: updateCheckFrequency

Syntax: updateCheckFrequency [parameter]

Parameters: One of the following strings: weekly or  monthly or via menu 
only

Function: Specifies whether and how often DarkAdapted performs an auto-
matic Internet update check for new versions.

Examples: tell application "DarkAdapted"
 updateCheckFrequency "weekly"
 updateCheckFrequency "monthly"
 updateCheckFrequency "via menu only"
end tell

Section 4:  
Troubleshooting

4.1 —  Error Messages in Windows
Some versions of Windows do not automatically adjust an application’s use 
of memory. If DarkAdapted exceeds the amount of RAM allocated to it, the 
program may display an error message, or it may crash. 

If you are running DarkAdapted X under Mac OS X, then this section is not 
applicable.

Many error messages are memory related, so — if you frequently encounter 
error messages, you may wish to allocate more memory to DarkAdapted. 
Consult your computer’s documentation as to how you may allocate more 
memory to an application program.

If you encounter error messages that you believe may be caused by an error 
within DarkAdapted, then take careful note of any error messages that appear, 
along with steps that lead to a reproducible error, and e-mail the information 
to us. We’ll do what we can to identify, reproduce, and correct the problem.

Make sure you have 2 MB available RAM in which to run DarkAdapted, espe-
cially if you have added many presets or scheduled events. DarkAdapted 
runs well under virtual memory and with most popular memory-doubling 
technologies.

If problems persist, try restarting in “safe mode,” as described in your com-
puter’s documentation.

4.2 — My Monitor is Stuck at Reduced Brightness!
This usually occurs if DarkAdapted or your system has crashed, leaving your 
monitor’s gamma ramp in a modified state.

First off, do not panic! It’s easy to restore your monitor to full brightness. 
 Simply restart your machine to return your monitor to its default 
gamma setting. If this is not effective, open your Display control panel 
and click the Settings tab. Change your Colors control to a different value 
and back again. As a last resort, try reinstalling your video driver to 
clear the “stuck” gamma preference.

 Under Mac OS X, select System Preferences... from the Apple 
menu. Select the Displays preference pane, then click on the Color 
tab. Click to select a different Display Profile, then select the original 
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(or any desired) profile to reset your gamma. If this does not work, 
you may have to restart your machine.

4.3 — Common Problems
DarkAdapted does nothing on my system.

This occurs most often with Windows-compatible machines. While 
DarkAdapted functions well with many Windows systems, it cannot sup-
port all possible hardware/software combinations. Generally speaking, if 
your hardware supports standard gamma change routines, DarkAdapted 
will work on it.

DarkAdapted doesn’t affect some of my screen colors.

Windows does not consider white when modifying gamma values. Some 
users have reported success via changing the Windows theme to the “Classic” 
value.

My gamma setting is not persistent.

Most systems will reset the gamma ramp when you restart, when a screen 
saver exits, or when your system sleeps and wakes. DarkAdapted will not 

“know” about this event and may not reset the gamma. The solution is to 
enable the Refresh gamma values control in the Preferences window.

DarkAdapted contains several presets for Red and Green; why not Blue?

DarkAdapted was developed to help preserve the user’s dark adaptation. 
Red is most widely regarded as the best choice for this purpose, while green 
also has its adherents. Blue is not generally recommended to preserve dark 
adaptation, so no presets are supplied in the blue range.

If you’d like to add blue presets, check out the supplied file “Blue Presets,” 
which is part of the DarkAdapted download package.

DarkAdapted does not affect all of my monitors.

Version 1.3.1 introduced multiple monitor support. If you are using version 
1.3.1 or later, make sure you remove any prior versions of DarkAdapted, then 
restart your system to enable control of all connected displays.

I receive error messages when I open the program.

If you are running DarkAdapted for Windows, then the first issue you should 
suspect is a memory problem. Try allocating more memory to DarkAdapted 
as described in your computer’s documentation or on-line help system.

It is also possible that the file “DarkAdapted Prefs File” has become dam-
aged. In Mac OS X, “DarkAdapted Preferences” is located in the active User’s 

“Library” folder, in the “Preferences” folder. In Windows, the file is located in 
the same directory as DarkAdapted.

The preferences file must remain unlocked and in place while you use the 
program; otherwise, DarkAdapted will be unable to write preference infor-
mation, and an error message will be generated.

I receive error messages when I quit the program.

See the above discussion concerning the file “DarkAdapted Prefs File.” Your 
startup disk must be writable (i.e., it cannot be a CD-ROM or other read-only 
medium). Otherwise, DarkAdapted will be unable to save preference infor-
mation when you quit the program, and an error message will appear.

I receive error messages while using the program.

If DarkAdapted reports an error while you are using the program, one of the 
following is likely to be true:

•  The program has run out of application memory. There isn’t enough 
memory to store additional data or display a graphic. This should not 
occur when running DarkAdapted X under Mac OS X, because Mac OS X 
dynamically allocates memory to application programs.

•  The program has attempted to write data to a disk that is locked or read-
only. This may occur when saving a file, when the program writes to its 
preferences file, or when writing temporary files to disk.

•  The program has attempted to access a file that has been moved or deleted 
since DarkAdapted last attempted to read from it.

•  The program contains an error that causes unexpected results that have 
not been anticipated (a “bug”).

Make sure also that DarkAdapted and its support files are installed on an 
unlocked disk, and that you have started your computer from an unlocked, 
writable startup disk.

If you believe you have found a bug in the program, let us know! DarkAdapted 
contains many thousands of lines of programming code, and it is unrealistic 
for us to expect that we have anticipated every possible situation. If the situ-
ation is repeatable, please outline the steps that are required to reproduce the 
problem. Support information is described in the following Section.

4.4 — Technical Support
Consult the “Read Me” file in the Documentation folder — or click the link in 
DarkAdapted’s Main Window — for technical support contact information.

Additional information is available at the DarkAdapted web site.

http://www.adpartnership.net/DarkAdapted/index.html
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